
YBK  essentials
Y O U R  G U I D E  T O  A L L  T H I N G S  Y E A R B O O K

 

D I R E C T I O N S 
Please refer to pages  

6, 8 and 10-11.



REP
Design ideas, including cover and theme
Curriculum and training
Sample books
Staff organization
Pricing questions

CSA (CUSTOMER SERVICE)
Answer production questions
Deadline information
Shipping information
Turning on cover templates
Person to call when rep is unavailable

TSA (TECH SUPPORT)
Assistance with book setup
eDesign and eBusiness setup
Submitting pages
Uploading portrait CDs
Support for InDesign plug-ins
Answer questions about software 
Tech troubleshooting

WHO 
TO 
CALL

THEY’VE GOT YOUR BACK,  
SO ALWAYS HAVE THEIR 
CONTACT ON HAND.

YEARBOOK REPRESENTATIVE (REP)

Name:	

Email:	

Phone:	

CUSTOMER SERVICE ADVISER (CSA)

Name:	

Email:	

Phone:	800-255-6287

TECHNICAL SUPPORT ADVISER (TSA)

Phone:	877-362-7750 

Email:	 techadviser@herffjones.com

Live chat through eDesign

SCHOOL PHOTOGRAPHER

Name:	

Email:	

Phone:	

DETAILS TO KNOW BEFORE YOU CALL YOUR TSA OR CSA:

Your job number: 
Your school has a unique number to identify your files within the 
plant so they can find you easily. 

Operating system: 
What type of computers does your staff use?

Web browser: 
Which web browser do you use? They all operate differently, 
so knowing your preferred browser will help answer questions.

WHAT CAN 
THEY HELP 

YOU WITH?
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MYHJYEARBOOK.COM 

MYHJYEARBOOK.COM 

LEARNYBK.COM

BOOKMARK 
IT KNOW WHERE TO FIND 

EVERYTHING YOU NEED ONLINE 
TO CREATE YOUR BOOK

MYHJYEARBOOK .COM LOGIN CREDENTIALS

My username: 

My password: 

MYHJYEARBOOK.COM
This is your portal to all things yearbook, including eDesign 
and eBusiness. Also important to InDesign users, this site 
gives you easy access to deadlines, book sales and other 
critical information.

LEARNYBK.COM
Here’s a shortcut to the online curriculum, which serves 
as a companion to our 12-booklet How to Yearbook printed 
curriculum. It is also accessible through the Learn menu on 
myHJYearbook.com.

HJESHARE.COM
Also available as an app, eShare is an easy way for parents and 
students to share photos with you.

YEARBOOKORDERCENTER.COM
Customized for your school, this is where students and 
parents order yearbooks and ads, access Online Ad Creator 
and upload photos. If you use the order center, remember to 
include the address and job number on your sales posters.
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It’s more than just a list of topics to teach.  
How to Yearbook is a comprehensive guide to 
advising. From developing a theme to selling books, 
it’s packed with yearbook goodness. Written for 
both advisers and staffers, this 12-section set is 
ready for you to customize for your classroom. 

Extended resources can be found in our online 
curriculum, with downloadable answer keys, found 
at: herff.ly/answerkeys.

S E C T I O N  O N E

WELCOME TO HERFF JONES
A guide for new advisers.

S E C T I O N  T W O

TE AMS AND LE ADERS
Cultivate the community that works.

S E C T I O N  T H R E E

INTRO TO JOURNALISM
An overview of the basics.

S E C T I O N  F O U R

THEME AND VOICE
Unite the verbal and visual.

S E C T I O N  F I V E

COVERING YOUR SCHOOL
They all have stories to tell.

S E C T I O N  S I X

REPORTING AND WRITING
Use their words, not yours.

S E C T I O N  S E V E N

CAMER AS AND PHOTOS
Create a photo worthy of the spotlight.

S E C T I O N  E I G H T

L AYOUT AND DESIGN
Make it all fit together.

S E C T I O N  N I N E

TOOLS OF THE TR ADE
Online-only guides to eDesign and InDesign.

S E C T I O N  1 0

PEOPLE AND INDE X
Complete the history book.

S E C T I O N  1 1

SELLING YOUR BOOK
The book only matters if people buy it.

S E C T I O N  1 2

WORDS TO KNOW
Glossary and curriculum alignment.

HOW
TO 
YEARBOOK

EXPLORE OUR 
COMPREHENSIVE 
CURRICULUM
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WELCOME TO THE HERFF JONES YEARBOOK FAMILY. 

By now, you probably know your rep and have that 
number on speed dial. But did you know you’re 
part of a network of yearbook advisers, who all 
have similar goals and challenges? You are not 
yearbooking alone.

We know there’s a lot to do, so we’ve gathered 
the most critical get-it-done information into this 
handy guide. Follow this, and you’ll be in great 
shape. Find a fellow adviser with similar hopes 
and dreams, and build alliances. 

We know that yearbook programs come in all forms 
— clubs, classes large and small, staffers with 
dreams of national awards and staffers who are just 
there to have fun. But there are parallels in every 
yearbook room: Advisers who have a full load to 
teach. Advisers who are new to the position and  
have no idea where to start. Advisers who can only  
fit one hour of yearbook into their daily agendas.  
And everyone has the task of capturing the year  
and including as many students as possible. 

We get you, and we support your choice to do only as 
much as you choose. Break your tasks into bite-sized 
pieces and focus on making a fun, creative yearbook 
your school can be proud of. And, if you’re ready to 
set the yearbook world on fire, we’re here for you.

An adviser wears  
many hats…
1 — C O M P A N Y  P R E S I D E N T  p.5

•	 Produce a yearbook kids love and parents 
want to buy

•	 Maintain a financially sound business

•	 Sell and/or promote books to as many 
students as possible

•	 Sell ads to celebrate student milestones

•	 Sell ads to local businesses so they can 
support your school

2 — P R O D U C T I O N  M A N A G E R  p.9
•	 Produce a book on budget and on time

•	 Work with your representative and other 
Herff Jones support staff

3 — E D U C A T O R  p.17
•	 Empower students to become leaders in 

the classroom and in the school

•	 Teach skills in communication, 
journalistic writing, graphic design, 
photography and business

•	 Allow students to grow in an area of 
interest and build their skill sets

•	 Motivate students to work hard and to 
see the rewards of their work

4 — P R O G R A M  B U I L D E R  p.23
•	 Educate students, parents and school 

administrators about the benefits of 
taking yearbook

•	 Make your staff one that students 
want to join

•	 Build relationships on your staff
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WE’RE 
GLAD 

YOU’RE
 HERE.



1.  STUDENT AND FACULT Y NAME LISTS
Having complete name lists is really helpful and gives you 
a lot of functionality in eDesign. You need student names 
and grades to complete the portrait section and to ensure 
names are spelled correctly. A complete name list allows 
eDesign users to run coverage reports and spell check 
names. And that’s just the beginning. Herff Jones can 
run sales campaigns on your school’s behalf or you can 
customize and run your own.

Ask for a new list each year from your administrative 
office, and make sure it reflects new students, address 
changes, etc. Request the following fields (not all are 
required, but could be helpful): 

•	 REQUIRED: First, middle and last names (in separate 
fields)

•	 REQUIRED: Grade 

•	 Full mailing address (separate fields for address line 
one, two, city, state or province and ZIP or postal code)

•	 Homeroom or identifying class period

•	 Student ID or some unique identifier

•	 Parent email address

Also, get a list of faculty and staff members. Request the 
following fields:

•	 First, middle and last names (in separate fields)

•	 Substitute STA for staff or FAC for faculty in the  
grade field 

TROUBLESHOOTING:
If your front office questions your need for the student 
list, provide them with our FERPA policy, or PIPEDA/
FIPPA policy if you’re in Canada. These explain how Herff 
Jones is in compliance with laws related to using student 
information. Find them at herff.ly/sales-assist-how-to.

UPLOAD YOUR NAME LIST
Log in at myHJyearbook.com.
Go to Setup > Set up Sales.
Then click the Name List tab on the left.

IMPORT LIST TO EDESIGN
Log in at myHJyearbook.com.
Go to Setup > Set up Book.
In the Master List tab, import your list to eDesign.
Note: It may take up to 15 minutes for your name 
list to be available in eDesign after uploading to 
eBusiness.

If you need help, access the video tutorials under 
the Learn menu. And, if you really run into trouble, 
call your TSA for assistance.

2. PL AN YOUR FINANCES: MA JOR TO-DOS!

 Refer to How to Yearbook and LearnYBK.com  
Section 11: Selling Your Book.

BUDGET — GETTING STARTED

1.	 If you’re new, you should still be able to access 
eBusiness records from the previous year. Work 
with your rep and bookkeeper to see how last year’s 
budget worked.

2.	 Use the Budget History and Goals worksheet (in 
print Section 11, p.33) to work through important 
questions.

3.	 Do you intend to change the basic book specifications 
(cover materials, number of pages, number of copies 
printed, additions such as supplements or tip-ins)?

BOOK SALES

•	 How many books will you sell?

•	 What price structure will you follow? 

•	 Will you have tiered pricing or one price all year?

•	 Can you sell books at registration or  
back-to-school night(s)?

•	 How will you promote your book?

AD SALES

•	 Will you sell ads to families, students and/or 
businesses?

•	 What price structure will you follow?

•	 How will you accomplish ad sales? 

 
3. GET YOUR BOOKKEEPING UNDERWAY
Once you get through all of the decisions for book and 
ad sales, you can set up eBusiness, powerful business 
tracking software available only from Herff Jones. Go to 
MyHJyearbook.com and click on Set up > Set up Sales. 
Ask your rep or your TSA for help as needed. 

Find your deposit due dates on MyHJyearbook.com  
under Deadlines.

ONLINE HELP 
Access through the Learn menu of MyHJyearbook.com

 

1. COMPANY PRESIDENT
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4 . MAKE A YEAR-LONG MARKETING PL AN
Not every school has to sell books. (Some schools include 
it in student fees.) Still, for the good of your program, we 
think promoting your book in your school and community 
is important. For the rest, book sales are critical (and easy 
to shelve — there’s just so much to do). 

Take some time to review the new sales materials we’ve 
included in this kit. The poster and accompanying adviser 
guide are meant to help you and your staffers keep 
book sales and promotion on your agenda all year long. 
Additional sales materials are also available on herff.ly/
ybk-shop.

5. SELL BOOKS

 Refer to How to Yearbook and LearnYBK.com  
Section 11: Selling Your Book.

For your students, the process of selling/promoting the 
book fosters a new and valuable skill set beyond producing 
the book itself. 

In addition to the marketing plan poster and adviser 
guide, we’ve provided samples of sales posters and flyers 
in this kit. Use them, write your sale dates and other 
important information on them – don’t forget to include 
YearbookOrderCenter.com and your job number – and 
order more as needed from herff.ly/ybk-shop. See page 7 
for more.

IDEAS FOR SALES SUCCESS

•	 Do whatever you can to include the yearbook as 
part of registration. Include it on forms, sell it at 
registration, have it included in fees.

•	 Create incentives to parents and students for 
purchasing early. Tiered pricing — starting at a lower 
price and raising prices after an introductory sale — 
rewards early buyers and is a great idea.

•	 Keep all the messaging positive. Make buyers feel 
great about their purchase.

•	 Set up a table at freshman orientation or back-to-
school night. 

•	 Use every communication channel available, 
including registration packets, emails, social media, 
morning announcements, automated phone calls 
and marketing materials in high-traffic areas.

•	 Post sneak-peeks of content and behind-the-scenes 
photos of how the book comes together.

•	 Build buzz around yearbook distribution day. Host an 
event exclusively for buyers.

this is a business you’re running

SETTING UP TIERED PRICING 
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MAKE BOOK SALES EASY
Sales Assist is an email-based yearbook sales 
campaign for you. We answer the calls and questions, 
so you don’t have to. We take online and phone orders. 
We process payments. We follow up on delinquent 
checks as necessary. 

Best of all, it’s included in the base price of your book. 
Let us help you with the business side because putting 
the yearbook together is enough work. 
 
Our online accounting software, eBusiness, maintains a 
transaction register of online and in-school book and ad 
sales in one database.
 
That makes generating and printing reports to check and 
share your sales status as easy as a click. You can keep 
an eye on your ad and book sales progress from your 
myHJyearbook dashboard.

HOW IT WORKS

1.	 Targeted email campaign. The campaign follows best 
practices for email sales. You can enroll when you 
are ready, and your list will be included in the next 
scheduled send. Unenrolling when you’re done takes 
just one call. 

2.	 Once parents make a purchase, they are excluded 
from future communications about book and ad 
sales. If you sell books in school and enter sales in 
eBusiness, those buyers will also be excluded from 
future emails. Make sure your eBusiness sales are  
up to date. 

 
3.	 Matching posters are included in the kit so you can 

coordinate your in-school marketing with the email 
campaign. If you run out of posters, order more from 
herff.ly/ybk-shop. 

 
4.	 We provide campaign-branded web banners for 

your school’s and staff’s websites. Give these to your 
programmers and ask them to link the image to your 
Yearbook Order Center page.  
 

For more information, go to herff.ly/sales-assist.

FOLLOW THIS FORMULA TO FORMAT THE URL: 

yearbookordercenter.com/index.cfm/job/XXXX.  
Replace the XXXX with your job number. 

 
 

HOW TO ENROLL

1.	 Get a list of parents’ email addresses. (Mailing 
addresses are optional; see p. 4 for more.)

2.	 Contact your rep to enroll and help you upload 
your list. 

Keep your eBusiness records updated for best results. 

SEND AND SELL
In addition to Sales Assist, eDesign users can 
generate their own customized email campaigns. 
It pulls from your uploaded name and email list to 
send reminders to parents who have not purchased 
a book. Use pre-designed email messages or make 
your own. Click, click and you’re done. Check out the 
video tutorials under the eDesign Help menu. Don’t 
forget to enter your in-school sales into eBusiness, 
before sending.

ADDITIONAL TOOLS TO HELP YOU SELL 
Customize your marketing and sales efforts to fit your 
school. While we have included samples in this kit, 
additional resources are available on herff.ly/ybk-shop.
 
Posters, banners and yard signs 

•	 Book sales

•	 Senior ad sales

•	 Prices are going up

•	 Distribution day

•	 General yearbook awareness

•	 Last chance for yearbooks

Letterhead, Create and Share
Order a stash of letterhead to send letters to 
businesses for ad renewals. Use our Create and Share 
function in eDesign to print fliers and pre-designed 
templates. Check out the video tutorials under the 
eDesign Help menu.

SALES ASSIST



707

B U Y  Y O U R  Y E A R B O O K  T O D A Y !

0 0 0 - 3 6 7  ©  H e r f f  J o n e s  L L C

Don’t miss out.

You’ll see on  
distribution day.

SALES POSTERS (two designs available, found in the kit)

SALES BANNERS (seven designs available)YARD SIGNS

ORDER  
TODAY

STATIONERY

(one-sided or two-sided options available)
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BACK

FRONT

ENVELOPE

Y E A R B O O K  I S  A  L O V E  L E T T E R  A  S C H O O L  W R I T E S  T O  I T S E L F .

Y E A R B O O K  I S  A  L O V E  L E T T E R  A  S C H O O L  W R I T E S  T O  I T S E L F .

SALES FLYER (found in the kit)

Don’t miss out on
your memories.

BUY
YOUR
YEARBOOK

0 0 0 - 4 3 3  ©  H e r f f  J o n e s  L L C

Don’t miss out on
your memories.

BUY
YOUR
YEARBOOK

0 0 0 - 4 3 3  ©  H e r f f  J o n e s  L L C

Find all these helpful items and more at herff.ly/ybk-shop.



1.  MAKE A MASTER CALENDAR
Make the rounds and find all of the dates that affect your 
school and your yearbook production schedule.

PLANT DEADLINES

Know your page submission deadlines for the plant. Your 
final page deadline is especially important since missing 
the final deadline may cause your ship date to be pushed 
back. Mark the plant deadlines on your own calendar, for 
sure, but consider making another set of deadlines that 
you share with the staff. You want your staff to complete 
pages a few days before the plant deadlines to give 
yourself time for proofing and submission. 

•	 Staff deadlines and mini-deadlines — Depending 
on how your staff is organized, break deadlines into 
bite-sized pieces. Many advisers have teams submit 
stories and spreads weekly or bi-weekly.

INCLUDE ON MASTER CALENDAR:

•	 Spread deadlines (for staffers)

•	 Staff workdays

•	 Cover and endsheet due dates

•	 Copy count deadline

•	 Personalization list deadline

•	 Book sales events

•	 Price increase dates for tiered pricing

•	 Ad sales deadline

•	 Ad submission deadline

•	 Picture day(s)

•	 Make-up picture day

•	 Club picture day(s)

•	 Sports team photo days (fall, winter and spring)

•	 Major sports events

•	 School activities (dances, rallies, assemblies)

•	 Theater/music/dance performances

•	 Club/organization events

•	 School holidays

2. BUILD A L ADDER
In yearbook, the ladder is simply a chart that helps you 
plan what will go on each page and track pages and 
spreads as they are completed and sent to be printed. 
See p.13 to start planning, then use the wall and desk 
ladders in this kit to chart your coverage for the year. Move 
it all over to eDesign (if applicable) and include staffer 
assignments and deadlines. 

 Refer to How to Yearbook and LearnYBK.com  
Section Five: Covering Your School for more help.

SET UP YOUR LADDER IN EDESIGN

1.	Log in to eDesign: Go to myHJyearbook.com.  
Click on the Design menu and choose Pages.  
You’ll see all the spreads in your book with thumbnail 
previews and information about each page.

2.	Create topics and assign to pages: You’ll want to 
create topic tags for each page in your book. You can 
use these same topics to tag photos to save time. See 
the tutorial in eDesign Help on creating topic tags.

3.	Assign topics to pages: See the tutorial in eDesign 
Help on setting up the ladder.

4.	Assign deadlines and staff members: If you are 
working with a staff, assign each staffer to specific 
pages in the ladder. See the tutorial in eDesign Help 
on setting up the ladder.

 S I G N AT U R E  1         S I G N AT U R E  9        S I G N AT U R E  5        S I G N AT U R E  1 3      S I G N AT U R E  3        S I G N AT U R E  1 1       S I G N AT U R E  7       

 S I G N AT U R E  2        S I G N AT U R E  10       S I G N AT U R E  6        S I G N AT U R E  1 4       S I G N AT U R E  4        S I G N AT U R E  1 2       S I G N AT U R E  8        

W H O ’ S  T H E  M O S T 
O R G A N I Z E D  

O F  T H E M  A L L ?

Map content for your 

pages, and assign teams, 

writers or photographers.

Consider color-coding  

your deadlines.

The plant cannot print 

a signature until every 

page of that signature is 

submitted, so planning 

your content is important. 

Celebrate when you  

finish each signature! 

on the
WALL

LADDER,
LADDER

J O B  N U M B E R

REP:  N A M E  A N D  C O N T A C T  I N F O

CSA:  N A M E  A N D  C O N T A C T  I N F O

TSA:  N A M E  A N D  C O N T A C T  I N F O
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WALL LADDER, DESK LADDER AND CALENDAR  

are included in kit to help you plan.

2. PRODUCTION MANAGER
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3. MAKING AN OFFICIAL RECORD
A yearbook serves as the official record of the school 
year. Your goal should be to include every student, faculty 
and staff member in the book as many times as possible. 
Although every book is different, here are some items you 
may wish to include:

BASIC COVERAGE:

•	 Individual portraits for students and faculty

•	 Club and organization photos

•	 Sports team photos

•	 Scoreboards with opponents, wins and losses 

•	 Some coverage of every sport and academic area

•	 Major events of the school year

WAYS TO DESIGN A COVER

1. CHOOSE A COVER
You have the option of choosing a pre-designed cover or 
designing your own. Refer the YBK Innovations booklet for 
more information.

2. DESIGN YOUR OWN COVER
You can design a cover in eDesign using the cover 
template or have your CSA activate the cover designer for 
silkscreen covers. You can use the same eDesign tools you 
use on pages to create a custom cover design or use one 
of our cover designs or starter designs.

3. MEET WITH A COVER ARTIST
You can have a custom cover designed by a plant artist for 
an additional charge.

BASIC BOOK ELEMENTS:
•	 Cover: Theme, book title and year.

•	 Spine: As space allows, school name, city and state. 
Then, year and volume. Then, book name and theme,  
if it fits. (Doesn’t apply to soft-cover books.)

•	 Title page (page 1): Book title, volume number, 
year, school name, complete address, city, state/
province, postal code. Since you are creating a 
record of the year, it’s important to include the basic 
information here. Some schools include number of 
enrolled students and faculty/staff members.

ALSO CONSIDER:
Table of contents printed on front endsheet. Dividers 
can include a table of contents for the section.

Bylines for writers and photographers.

Folios with page numbers, section title and page or 
spread topic.

Index at the back of the book, before the colophon and 
closing. It should help readers locate any included subject 
or topic, such as all people, academic topics, advertisers, 
clubs, sports and events. 

4 . FIND YOUR WOW
There are so many ways to make your yearbook stand out 
each year. Whether you choose a new cover material or 
special paper, laser cut endsheets or glitter UV coating, 
take some time to talk through the options with your rep. 
You might be surprised how some simple and inexpensive 
additions increase your sales and add to your book’s value.

5. SUBMIT TING PAGES
Follow the steps on p. 12–13 of this booklet.

WHAT IF YEARBOOK IS A CLUB?
Yearbook clubs can be every bit as productive 
as yearbook classes. However, advisers have to 
motivate students with a force more powerful 
than grades. If you have a small staff, a club can 
supplement the staff’s work or allow students  
with packed schedules to get involved. 

SUGGESTIONS:

•	 Attend a summer camp or hold boot camp 
training sessions for campers.

•	 Create an incentive system for staffers so they 
can earn a free book, a free ad or perhaps a 
discount on attending a workshop.

•	 Plan work nights when a deadline is looming. 
Have students bring part of a meal. Taco night, 
ice cream sundae bars, baked potato bars are 
all fun and simple.

•	 Consider offering membership in organizations 
such as Quill and Scroll for high school as a 
benefit to successful club participation.

ONLINE HELP 
Access through the Learn menu of MyHJyearbook.com

a yearbook serves as a historical record
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DEADLINES EXPL AINED:
DEADLINES: Plant deadlines are usually based 
on what was done last year. If you see a conflict 
with a date or would like to redistribute pages on 
deadlines (within reason), let your rep know by 
the first week of September for spring delivery 
books and the first week of October for summer or 
fall delivery books. Your rep will then submit your 
request to the plant for approval.

CREDIT FOR OVERRUNS: Herff Jones often 
sends more copies of the yearbook than ordered. 
You can use them to replace any books damaged 
in transit, or sell them on distribution day. If you 
don’t sell them, you can return them for credit.

CONFIRM PAGE COUNT: If you increase or 
decrease your page count, let your rep know how 
you want to adjust your deadlines. Remember, your 
page count can affect your cover/spine.

PERSONALIZATIONS: These include 
name plates and name stamps. Access your 
personalization list in eBusiness. Submit your 
list to the plant on time to avoid late charges, 
but make sure to double-check spellings first. In 
eBusiness, go to Run Reports > Sales Reports > 
Personalization > Send Personalization to Plant.

OTHER IMPORTANT INFORMATION:
PORTRAIT FILES: If you’re new to yearbook, 
contact your rep when you receive the portrait files 
from your photographer. Your rep can help you 
flow portraits. Communicate with your rep about 
picture days and when you expect to receive the 
files from the photographers. Because portraits 
are a huge part of your book, this will be important 
when allocating pages toward your deadlines.

RETURN PROOFS: Contact your rep when you 
receive your cover and endsheet proofs. Return 
proofs to the plant within 10 days of receipt.

PRE-PLANNING: When your book is done, 
and while the information is still easy to access, 
prepare for the upcoming year. With your rep, 
review submission and sales deadlines, book 
prices and ad prices. Doing this legwork means 
your rep won’t have to bother you over the summer 
and you’ll be ready to go when the rush of the new 
school year begins.

PL AN YOUR YEAR

DATE:		  DEADLINE:

	 Confirm all deadlines listed below

	  	 Last day for credit of previous year’s overruns

	 First deposit due  $ 

	 Cover/endsheet specs and artwork due

		  Confirm page count

	   pages due

		
	   pages due	 	

		
	 Final copy count due

	   pages due

	 Personalization lists due 
		  (discontinue sale of personalizations)

		  World Yearbook, autograph supplement 
		  and plastic cover orders due

	   pages due

	   pages due

		  Second deposit due  $ 

	 Set up planning appointment for next year

		  Final invoice due  $ 

		  Requested ship date  

		  Preferred arrival date  

		  Distribution day  

TOTAL PAGES:  	 TOTAL COPIES: 

PLANNING AHEAD
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PLANNING AHEAD
SAMPLE FORMUL A USED BY A L ARGER BOOK : 
Student life: 25 percent 	 	

Pages available x .25

New coverage ideas for this section:

Academics: 15–20 percent	 	

Pages available x .15

New coverage ideas for this section:

Organizations: 10–15 percent	

Pages available x .15

New coverage ideas for this section

Sports: 15–20 percent	

Pages available x .20

Pages per varsity sport	

Pages per junior varsity sport	

Pages per freshman/sophomore sport	

New coverage ideas for this section:

Portraits: 25–30 percent	 	

Pages available x .25	

Seniors/Eighth	

Juniors/Seventh	

Sophomores/Sixth	

Freshmen	

Faculty/administration/staff	

New coverage ideas for this section:

TOTAL CONTENT PAGES:	

STEP-BY-STEP L ADDER PL ANNING 
Just as you would never build a house without a blueprint, 
the ladder helps you start your yearbook planning. 
This is the page-by-page listing of the book’s contents. 
The number of pages to include is based on financial 
considerations and the number of students at the school. 
Some books may have fewer pages dedicated to non-
portrait pages, the formulas here are traditional — and 
guidelines, not rules. They are also a better fit for high 
schools. Start by determining the number of pages in 
your book, and look through previous books and see how 
they’ve been organized. See the Covering Your School 
section of How to Yearbook for more details.

Coverage, which means including as many students 
in the yearbook as possible, should be:

•	 Complete and accurate

•	 Fair and balanced

•	 Fresh and lively

BALANCE THE BOOK
Organize pages beginning with the most popular section, 
followed by a less popular section, followed by a more 
popular section, and so on to maintain maximum interest. 
Consider varying the order of sections from year to 
year. Chronological books sometimes combine several 
sections. If you do not have an all-color book, use color in 
areas where it will appeal to the most students. Move the 
color from year to year.

Total pages in the yearbook	

Theme pages

Title page/closing page		

Opening			 

Dividers (if used)			

Closing			 

Advertising (optional)		

Index				  

Magazine/supplement (optional)	

(Subtract the totals above from the total book pages  

to figure pages available for content.)

Pages available for content 	

Note: Some schools subtract portrait pages from the 
pre-content total, as those may be the same from year 
to year. To make the math work, add five percent to 
each remaining section.



PROOF. PREFLIGHT. SUBMIT.
THE eDESIGN WORKFLOW FOR PAGES 
A page in eDesign passes through several stages before it is 
submitted. The stages help you monitor progress and track what’s 
been done to each page. In eDesign Help, search “Workflow for 
Pages” and “Preflight” to view related video tutorials.

 
No edits have been made. The page moves to the 
Edited stage after changes are made and saved on 
the page. Only the people assigned to the page or the 
adviser can edit a page. 

A page remains in this stage while the assigned staff 
members are working. When the page is ready for 
review by the adviser or editor, click Proof. 

In this stage, edits can only be made by the adviser 
and assigned editor. Move a page to the next stage by 
clicking Preflight Ready.

The page has been proofed and is ready for preflight 
by the adviser.

1.	 Click Run Preflight.

2.	 Open the adjoining page to preflight the spread.

3.	 Review any preflight alerts and make corrections 
if necessary (see the list on this page). 

4.	 Click Finish and type any special instructions. 

5.	 Click the OK button.

Always generate a high-res PDF of the final 
version of each page and carefully review it 
before submission (File > High-res PDF). The 
PDF represents what will print, so be sure it 
appears as expected. This is your proof before 
submission.

In this stage, the page has been proofed, preflighted 
and approved by the adviser. It can only be unlocked 
by the adviser. Pre-Submit is the final step before 
submitting to the plant.

The adviser has submitted the page to Herff Jones, 
and the page has begun its process at the plant.

Displays on pages with deadlines in eDesign that 
have passed. The eDesign deadlines are set by the 
adviser and editor for production planning and do not 
necessarily reflect the plant deadlines. 

NEEDS WORK: The Needs Work link on a page in 
the ladder moves a page from any stage back to Edit 
mode so the assigned staff members can access it. 

Unedited

Edited

In Proof

In Preflight

Pre-Submit

Submitted
mm-dd-yy ET

Overdue
### days overdue

UNDERSTANDING PREFLIGHT 
In Preflight Check, alerts appear in the vertical bars to 
the outside of each page. If you click on the alert, eDesign 
selects the item on the page the alert references. If you 
hover over an alert, eDesign gives a brief description of the 
issue. The different alert types are described below. 

Preflight issues definitions: 

•	 Invisible content: If the page contains frames with 
no stroke, fill, or content, you are given the option to 
delete the empty frames.

•	 Text across the gutter: Indicates a text frame that 
touches or crosses onto the adjoining page. Make 
sure no text will be lost in the gutter when the book is 
bound.

•	 Bleed object: Identifies an object that is very near 
the edge of the page but that does not fully bleed off 
the edge. Bleed elements must extend to the outside 
edge of the 1-pica red border around the spread.

•	 Picture box: Indicates an image that does not 
completely fill the photo frame.

•	 Image resolution: Appears when a photo’s 
resolution is too low for the highest print quality. A 
DPI warning also appears on the image.

•	 Transparency: Indicates images that have 
transparency applied. These images will be PNG not 
JPEG, and will not be color enhanced at the plant. You 
do not need to fix this. Preflight is just bringing it to 
your attention.

•	 Embedded image: Identifies non-JPEG images. 
These are not color enhanced at the plant. You do 
not need to fix this. Preflight is just bringing it to your 
attention.

•	 Placeholder text: Identifies placeholder text that 
has not been replaced with actual text.

WHEN A PAGE IS LOCKED

PADLOCK ICON: Only one person can edit a 
page at a time. A padlock indicates the page 
is currently being edited by another person. 
An adviser can “force unlock” a page from 
the ladder if needed.
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FILTER BY PAGE STATUS 
Use the search drop-down menu at the upper right 
in the ladder to filter by a certain page status. Show 
only pages that are In Proof, Pre-Submit, etc.

S U B M I S S I O N
Once a page is in the Pre-Submit status and a 
final PDF has been reviewed, the page can be 
submitted. 

You do not have to submit all the pages for your 
deadline at once. You can submit smaller batches 
as you complete them.

SUBMITTING ONE PAGE AT A TIME

Pages can be submitted individually:

1.	 The page should be in the Pre-Submit status.

2.	 Click a page’s Submit button.

3.	 In most cases, leave the special instructions 
area blank.*

4.	 Click the OK button.

MULTIPLE PAGE SUBMISSION 

Submit several pages in Pre-Submit mode: 

1.	 Hold down the Ctrl key on Windows or the 
Command key on Mac and click to select the 
pages to be submitted.

2.	 After selecting all the pages to submit, go to 
the File menu and click Submit Pages.

3.	 In most cases, leave the special instructions 
area blank.*

4.	 Click the OK button.

EXPRESS SUBMIT  

Quickly submit multiple pages at one time:

1.	 In the ladder, click the drop-down menu 
in the upper right to filter and select Pre-
Submit. 

2.	 You then see only pages in the Pre-Submit 
status. The Express Submit button also 
appears at the top of the ladder.

3.	 Click the Express Submit button.

4.	 Then click OK.

ADVANCED SEARCH
The Advanced Search option (see below) can be launched with the link 
at the top right of the ladder. Advanced Search allows you to filter your 
ladder in a variety of ways. Most helpful are the options to filter by a 
deadline and by the student assigned.

SAVE IT FORWARD
After you submit your final pages, you’ll be given the option to transfer 
templates to the next year’s book. Be aware that the images, portraits, 
fonts, colors and art are transferred along with the template. You also 
have the option to use Save it Forward to transfer other settings such as 
your list of topics, ladder designations, staff, etc. Refer to eDesign Help 
for more information.

ALWAYS REVIEW HIGH-RES PDF  
You generate PDFs from the File menu.  
Use a low-resolution PDF for non-final quick 
proofs. A high-resolution PDF should be 
reviewed by the adviser before submission. 
Viewing a high-res PDF at 300 percent 
gives a good representation of the quality of 
images, etc. Be sure you’re happy with the 
appearance of the high-resolution PDF. The 
PDF represents how the page will print. 

THE IMPORTANCE OF PROOFING

*Special instructions are reserved for technical 
printing requests (special lamination, special 
paper stock, etc.). Discuss these options with 
your rep or CSA.



PORTRAITS
THE PORTRAIT PROCESS
Portraits are incredibly important, so set aside 
plenty of time to ensure all portraits are included 
in the right grade or class and that all names are 
spelled correctly.

For detailed guidance on the portrait process, click 
Working with Portraits in the sidebar in eDesign 
Help or call the tech support line for assistance at 
877.362.7750.

STEP 1: OBTAIN THE PORTRAIT DISK
Obtain the portrait disk from your school 
photographer. Use the one made for yearbook. It 
is formatted according to PSPI (PSPA) guidelines. 
Some photography companies send a CD, and 
others send a link to download the file.

STEP 2: UPLOAD THE PORTRAIT FILE
In the Portraits section of the eDesign Library, 
you’ll see a button to upload a Portrait CD. 

STEP 3: FLOW THE PORTRAITS
Use eDesign’s Portrait Flow to place portraits 
and names onto the pages. It flows them in 
alphabetical order in groups you designate (by 
teacher or by grade). Do not put empty portrait 
frames onto pages first. eDesign does it for you. 

STEP 4: PROOF THE PORTRAIT PAGES
Either print the portrait pages or email low-res 
PDFs to teachers or others able to assist: 

•	 Any misspelled names?

•	 Any missing portraits? 

•	 Any portraits with the wrong names?

•	 Any student listed in the wrong grade/class?

There is also an option to print directory proofs of 
your portraits. See eDesign Help for more info. 

STEP 5: CHANGES IN PORTRAIT LIBRARY
After proofing, make all changes to portraits 
in the portrait section of the Library, NOT on 
the pages. Switch to the Data View. Click into the 
cells to make changes to names and grades. Use a 
consistent format for grades and teacher names. 
Teacher names are needed if you plan to group 
students by teacher in the book.

STEP 6: RE-FLOW THE PORTRAITS
Open Portrait Flow again. A yellow yield symbol 
will appear next to any group in Portrait Flow that 
needs to be re-flowed. Select the portrait group 
and choose Edit. Portrait Flow remembers all the 
settings from when the section was last flowed. Re-
flowing the section will put the changes you made 
on the pages. Changes made in the Library will 
not go onto the pages until you reflow.

For step-by-step instructions, refer to Working 
with Portraits in eDesign Help.

INDESIGN USERS
InDesign users have plugins to make portrait flow easier. Go to 
MyHJyearbook.com > Learn > InDesign Help to learn more.

PORTRAIT FLOW WIZARD
The eDesign portrait flow wizard walks you through the process 
of placing portraits and names on pages. Select a page in the 
ladder, then go to Edit > Flow Portraits to launch.

NAME CHANGES IN PORTRAIT LIBRARY
Always make changes to names and grades in the portrait 
Library. Then reflow the section. If you make changes to 
names on pages, the changes will be lost if you reflow.

FINAL CHECK BEFORE SUBMITTING  
Before you submit any portrait pages, go to the Portrait 
section of the Library and do the following:

1.	 Use the menu at the top to filter by Unused.

2.	 Review the unused portraits to confirm they should not 
appear on pages.

3.	 If you discover any issues, make the needed changes and 
reflow the affected sections.

PORTRAIT PRO TIP
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BOOK ENHANCEMENTS 
PUT SOME BLING ON IT.
Consider these enhancements to add value to your yearbook 
and to help generate income for your program. Contact your 
rep for ordering and pricing details.

WORLD YEARBOOK* 
Designed for middle/high school readers, this 
16-page supplement documents events that 
made history during the school year. 

OUR WORLD* 
A scaled down version of 
World Yearbook intended for 
younger readers, the four-
page Our World supplement 
features photos and captions 
about this year’s most 
interesting news stories.

* If you purchase either of these for your entire order, 
you may choose where you want it to appear in your 
book (between signatures). If you don’t designate 
an insertion location, it will be added following the 
last page of your book. Smaller quantities are also 
available for purchase and come with Kleenstick® 
self-adhesive tape for easy placement in the books 
when they arrive.

PLASTIC JACKET
Hard-cover yearbooks 
stay protected and clean 
with these affordable 
plastic dust jackets.

AUTOGRAPH 
SUPPLEMENTS 
Eight-page autograph 
supplements can be 
added with Kleenstick®  
self-adhesive tape.

NAME STAMP
A name stamp is another 
personalization option. The 
student name is printed on 
the cover in foil. Printing 
student names on the cover 
leaves no question about 
whose book it is.

ENGRAVED  
NAME PLATES
Students can order metal 
plates engraved with 
their names and icons to 
customize their yearbook 
covers. Not recommended 
for soft cover books.



1.  TAKE TIME TO TEACH
Use the first weeks of the school year to establish the 
skills and routines to empower students to do the heavy 
lifting in yearbook. Not sure where to start? Begin by 
reading the Welcome section of the printed curriculum. 
Then, access all of the online resources at LearnYBK.com. 
The curriculum bundle includes a scope and sequence 
document, which provides a sketch of how to teach 
yearbook skills. If you’re looking for something a little 
less intense, check out the quick-start guides posted on 
LearnYBK.com. You can get to them by following this link: 
herff.ly/quickstart.

AT TEND A WORKSHOP
Yearbook workshops are a great way for students to begin 
planning their book during their summer downtime.  
Go to herff.ly/ybk-events for more information.

2. USE YOUR RESOURCES
THE PRINTED CURRICULUM: Available through your rep 
or for order on herff.ly/ybk-shop. The curriculum bundle 
includes 12 booklets that break down the topics you need 
to teach.

LEARNYBK.COM: The online curriculum is divided 
into the same sections as the printed piece. You’ll 
find the supporting documents you need to complete 
the activities. From sample staff contracts and book 
sales forms to vocabulary quizzes and PowerPoints, 
LearnYBK.com is where you’ll find resources to make 
your own.

TOP FIVE TAKEAWAYS AND POWERPOINTS: On the 
inside front cover of most printed curriculum booklets, 
you’ll find a guide to the five most important points of each 
section. The PowerPoint presentations on LearnYBK.com 
match these takeaways.

VIDEO TUTORIALS: Access our ever-growing library of 
video tutorials through the Learn menu of MyHJYearbook.
com. Find guided notes in Section Nine: Tools of the Trade 
in the online curriculum.

ADVISER ASSISTANCE EMAILS: Make sure you’re 
getting these weekly email from us. They’re filled with 
timely tips and tricks. We’re making sure you’ll never 
yearbook alone. 

MORE ONLINE RESOURCES: All of the online resources 
are available for a direct download from Google Drive. The 
link is included at the bottom of the Adviser Assistance 
emails. Also, answer keys to all of the lessons and quizzes 
are available at herff.ly/answerkeys. Cool, huh?

3. EDUCATOR

YBKNVA SUMMER WORKSHOP // Williamsburg, VA
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3. EMPOWER YOUR EDITORS
Especially if your editors are returning to yearbook, give 
them teaching assignments. Put them in charge. When 
it comes to eDesign, there’s even a special document for 
editors. It walks them through the major tasks of the year. 
herff.ly/edesigneditors

WHAT’S IN A THEME
Think of a theme as a storyline of the year. Themes provide 
visual and verbal unity for yearbooks. While they might not 
be obvious to every reader, a book with a theme presents a 
much better impression than a book without a theme. For 
theme development resources, see Section Four: Theme 
and Voice.

A GOOD THEME IS:
RECOGNIZABLE: Does it make sense as a framework for 
the whole book?

REFRESHING: Is it contemporary and different?

REPEATABLE: Can it easily appear on each theme spread 
without getting old? Can you come up with spin-off ideas?

REALISTIC: Is it appropriate to the students at your 
school this year? Does it relate to these students and this 
community?

RELEVANT: Is it relevant to each section of the book? Can 
the theme introduce each section without being forced? In 
20 years, will this theme seem relevant to the year in which 
it was produced?

If your theme is a storyline, think about what story you will 
tell. Here are some popular categories:

•	 We have a great reputation or legacy.

•	 We celebrate the individual as part of a larger group.

•	 We celebrate our group identity.

•	 Location. Location. Location.

•	 We’re all connected.

•	 Live in the moment. 

4 . TEAMWORK MAKES THE DREAM WORK
Staff organization varies from school to school and from 
staff to staff. Assess the situation and choose a hierarchy 
and organization that fits your teaching style and the 
students you have on staff. Check out Section Two: Teams 
and Leaders for ideas.This is just one staff organization 
chart we like. In this scenario, teams 1–4 are made up of 
reporters, writers and layout designers. The photo editor 
and business editors may also have teams.

5. DON’T FORGET  
THE BUSINESS SIDE
If you sell books, involve 
your entire staff in sales 
efforts. If your school sells 
ads, consider setting up 
an incentive for selling, but 
make sure grades are tied 
to effort, not money. Need 
more info? See Section 10: 
Selling Your Book and the 
additional sales resources 
included in the kit.

empower the storytellers of this generation

ADVISER
BUSINESS 
EDITOR

PHOTO
EDITOR

EDITOR

EDITOR

TEAM 3

TEAM 1

TEAM 4

TEAM 2



WORKING WITH IMAGES

eSHARE APP The eShare app is 
available in the App Store or the 
Google Play store.

IMAGE QUALITY 
The triangle means your photo will be fuzzy at the size it is on the 
page. Either choose a different photo or make the photo smaller.

PHOTOGRAPHY POSTER found in the kit. 

Photos create the biggest impact in your yearbook,  
so you’ll want to collect the best. 

 Refer to How to Yearbook and LearnYBK.com  
Section Seven: Cameras and Photos for more help.

PHOTOGRAPHY TIPS
DO set your camera’s image size to the appropriate settings.

•	 If you set it higher, your image will upload slowly, but you can 
make photos really large in the book.

•	 If you set it lower, your image will upload quickly, but you 
can’t enlarge photos much in the book.

DO make high-res PDFs and zoom in to 300 percent to see  
image quality.

DON’T take images directly off the internet or from someone’s 
social media site. There could be copyright and resolution issues.

DON’T ignore DPI warnings in eDesign on low-resolution images. 
Either make the image smaller on the page or choose another 
image for that spot instead.

CROWDSOURCE PHOTOS
Promote eShare and make photo requests in the school 
newsletter, via homeroom teachers, email or a note sent home 
with students. Include the eShare code on all advertising.

To set up eShare, go to MyHJyearbook.com > Transfer > Get 
Images from eShare > Preferences.

Use social media to request images of particular events. NOTE: 
You should NOT take images from Facebook or other social 
media sites for use in your yearbook. If you see an image you 
like, you can ask for the original and for permission  
to use it in the book. Also, don’t accept photos texted to you, 
request an email attachment for better quality. Remember files 
should be .jpg or .png. 
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EX AMPLES OF TAGGED PHOTOS 

TOPICS: Eighth Grade Boys’ Soccer
NAMES: John Richardson
KEYWORDS: against CMS, 7-2

TOPICS: Ms. Smith’s Second Grade
NAMES: May Reddle, CeCe Smith
KEYWORDS: Oak Hill Farm field trip

INDESIGN USERS
InDesign users have an extension called 
Image In to help with placing and managing 
images. Go to MyHJyearbook.com > Learn > 
InDesign Help to learn more.

ORGANIZING YOUR IMAGES
Advisers and editors create the topic tags for the book. These 
topic tags should correspond to all the content topics in your 
book. Topics can be used in multiple ways to save time and keep 
you organized. 

Advisers and editors can create topics in the Topics panel in the 
Library, in the Topics panel in the Ladder and in the Topics area in 
Book Setup.

TOPICS HELP YOU BUILD YOUR LADDER
Topics are applied to pages in the ladder to designate the content 
of each page. Topic tags can be created by advisers and editors 
in the Topics panel of the ladder. Just create the topic tag (if it 
doesn’t exist) and apply it to the correct pages in the ladder.

TOPICS KEEP YOUR IMAGES ORGANIZED
Topics are like the folders — but they’re better. Images can be 
tagged with more than one topic. That way a great image will 
appear for potential use on multiple pages (making the best use of 
your photos). The In Use indicator appears if an image is already 
used elsewhere so you can avoid duplicates. 

SHOWING YOUR TAGGED IMAGES
You can easily show the images tagged with a topic much like you 
open a folder on your computer. 

In the Library or in the Library panel in page 
design there’s a pull-down menu of all the topics. 
Select the topic from the list, and just those 
images appear.

In the Library you can also filter by topic tags by 
clicking the funnel icon to the right of the tag in 
the topic panel.

THREE KINDS OF TAGS
Topic tags are essential for good organization, but you can add 
names and keywords for additional benefits:

1.	 TOPICS: Tag images with the same page topics you used to 
build your ladder.

2.	NAMES: Tag images with names in the master list you 
import into eDesign.

3.	KEYWORDS: Tag images with extra information that might 
be helpful to you, especially more specific information (the 
event, the date, the opponent, etc.)

THREE WAYS TO UPLOAD IMAGES TO THE LIBRARY
Before uploading, decide which photos you’re most likely to use.  
It is best to limit uploads to the best photos.

1.	 IMPORT IMAGES: In eDesign, go to the Library and select 
the Images section. Click the Images button under Import 
Items and follow the prompts. You can upload up to 50 
images at a time.

2.	DRAG AND DROP:  In the Images section of the Library, 
click the Quick Image Uploader at the bottom. When that 
window is activated, drag and drop images from your 
computer. They will then upload to eDesign. You can upload 
up to 100 in a single batch. 

3.	WHILE EDITING A PAGE:  Open the Images section of the 
Library panel along the right in the page design area. At the 
bottom, click the Get More Candids link. 

 



DESIGNING PAGES
We offer a variety of predesigned layouts for both covers and inside pages. 
Activate them in the eDesign Library, and drag and drop them on pages. 
There are video tutorials in eDesign Help that show how to activate 
templates and how to put them onto pages. Then you can modify them any 
way you’d like. You may also create your own custom layouts.

STEP 1:  DECIDE WHICH L AYOUTS WORK BEST FOR YOU
We provide several layout collections to choose from. You can even mix 
and match if you wish.

•	 Book Looks and Go Design — These are two collections of 
professionally designed templates for eDesign. Each style has a 
unique design concept carried out with graphic elements, mods, 
theme suggestions, font suggestions and a color palette.  
(The Book Looks are compatible with Square OneTM. )

•	 Square One™ templates and mods — Square OneTM makes it easy 
to employ a contemporary modular design approach, empowering 
you to create a great-looking book that features lots of students. 
Search for Square OneTM in eDesign Help for more information.

•	 Other template options — The template library also includes 
many starter templates including: Layouts with captions and copy, 
layouts without captions and copy, single-page layouts and more.

STEP 2: ACTIVATE THE COLORS YOU WANT TO USE
Don’t pick colors based on how they look on screen nor based on how 
they look when printed from your desktop printer. These do not accurately 
show what colors will look like when printed on a printing press. 

Instead, look at the colors on the color poster. Make sure to refer to 
the poster that matches the paper you plan to use (gloss or matte).  
Each color has a CMYK code that matches colors in eDesign  
(for example, C=0 M=63 Y=73 K=0).

  C is cyan

  M is magenta

  Y is yellow

  K is black (key) 

Make note of the CMYK numbers and activate those colors in Book Setup 
in eDesign. Watch Activating and Creating Colors in eDesign Help for more. 
When you add colors in eDesign, you can name them for easy reference.

STEP 3: CREATE CHARACTER ST YLES
You’re not required to use character styles, but they can be an easy way 
to apply consistent text formatting in your book. There are video tutorials 
in eDesign’s Help Menu that show how to create and use Character Styles.

EXAMPLE: 	 AHJ Chantilly Bold 	 24 pt.	 CMYK = 43, 12, 17, 87

	 Headlines	 font 	 pt size 	 color 

	 Subheads	 font 	 pt size 	 color 

	 Copy	 font 	 pt size 	 color 

	 Captions 	 font 	 pt size 	 color 

ONLINE HELP
eDESIGN HELP:
MYHJYEARBOOK.COM > LEARN

•	 Activating a Book Style

•	 Activating and Managing Fonts

•	 Creating Character Styles

•	 Square OneTM

•	 Activating and Creating Colors

INDESIGN HELP: 
MYHJYEARBOOK.COM > LEARN

•	 Using Layout Builder

•	 Working with Square OneTM

•	 Color Swatches

•	 Character Styles

COLOR POSTER found in the kit. 
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STEP 4 : IF DESIRED, PL ACE ART ON PAGES
You can put a background on the background layer of your page or 
spread so it doesn’t interfere with other elements on the page. To do 
this, drag and drop a background on an empty area of a page in eDesign. 
When prompted, confirm you want it to be a background. You can 
remove it by clicking the background tool in the tool panel and clicking 
the clear button at the bottom.

You can also make an image the full spread background. To do this, draw an 
image frame with the shape tool the size of the full spread. Drag and drop 
an image from the Library into the frame. You may need to select the frame 
and choose Object > Send to Back to move it behind any images and text 
already on the page. 

There are videos eDesign Help that show how to activate art in the Library.

STEP 5: ADD HEADLINES, COPY AND CAP TIONS AS DESIRED
eDesign has a time-saving tool called Caption Builder that allows you to 
easily add names in captions. When you tag images with names from the 
master list, it will create text frames with correctly spelled names. Use 
that text frame to add a caption and format its font, color and style as 
you wish. There are video tutorials in eDesign Help that show how to tag 
images with names, how to spell check names in captions and how to use 
Caption Builder to create captions under photos.

Most Square OneTM mods include headline and copy packages set in a 
standard font. Once you choose and place these, you can change fonts 
and colors, and then add your own copy and photos.

FONT BOOK

AVA IL A BL E ONL INE AT  
HERFF.LY/FONTS-BOOKLET

•	 More than 500 fonts

•	 Explanation of types 
of fonts and tips for 
designing with fonts

GRAPHICS   collection
GRAPHICS BOOK  
AVA IL A BL E ONL INE AT  
HERFF.LY/GRAPHICS-BOOKLET

•	 Additional graphics

•	 Traditional graphics 
and clip art

•	 Mascots

•	 Borders and 
backgrounds

•	 “Just for Fun” graphics



1.  MAKE YEARBOOK A CULTURE
If being on the yearbook staff is fun and rewarding, if 
students are aware of the skills they are building and able 
to see their own growth, smart students will flock to your 
door. OK, so maybe not flock, but they’ll want to see what 
it’s all about.

ESTABLISH STAFF TRADITIONS
Celebrate birthdays and holidays, recognize good work 
with simple awards. Work nights = food fests.

BE INCLUSIVE
Make room for visual students and verbal students, for 
organized kids who can handle the business side and 
chatty Cathys who just want to interview people. Recruit 
vibrant personalities and the kids sitting quietly in the 
corner. Make yearbook that much more special because 
it’s made for everyone.

2. BUILD YOUR FAN BASE
Every student in your room should be educated on 
professional behavior when in yearbook mode. They 
need to understand that they represent your program. 
Those students, plus every teacher in the building, the 
counselors and the administrators should all be able to list 
the skills yearbook offers:

•	 Interpersonal communication

•	 Sales communication

•	 Telephone skills

•	 Interviewing

•	 Journalistic writing

•	 Graphic design

•	 Photography

•	 Specialized knowledge of the printing industry

•	 Leadership and team building

•	 Technology

•	 Time management and meeting deadlines

4. PROGRAM BUILDER

FOLIO MAGA ZINE
Our magazine to inspire and instruct  

is mailed to your school twice each year.
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3.  GO BEYOND
The goals of yearbook — to include every student, to 
highlight major events, to be a historical record of the 
year — put your staff in the perfect position to be an asset 
to your school and community. While some staffs include 
community service projects on their annual to-do lists, 
others provide free yearbooks to students who can’t 
afford them.

ONE WAY TO GIVE BACK
If you sell business ads, consider including the base cost 
of a book in the cost of the advertising contract. Give 
businesses the choice of either keeping the book that’s 
included or donating the book to a student who couldn’t 
afford one otherwise. Some staffs call this a “Yearbook 
Angel” program. Work with your administrators to identify 
the students who will receive the books. If you are in a high 
school, start with the seniors. Provide business donors 
with a thank you certificate or staff photo, and come up 
with a way to distribute the free books without making 
anyone the wiser.

4 . YOU’RE FAMILY
There are other ways to become engaged with your 
Herff Jones family. The most obvious is to connect with 
other advisers in your area. Yearbooking is in a category 
unto itself in the education world, and it’s nice to have 
colleagues you can reach out to. 

Here are a few other ideas:

COME TOUR OUR PLANT
Located in Edwardsville, Kansas, the doors are always 
open to you and your staff for plant tours, artist visits and 
more. Where else are you going to find a whole building full 
of people who care about yearbooks as much as you do?

VISIT US AT CONVENTIONS
We have booths (and giveaways) at most national 
conventions, including CSPA and JEA/NSPA.

ATTEND A WORKSHOP
Sponsored by sales partners around the country, summer 
and fall workshops are great opportunities for your staff 
to learn and grow together. Go to herff.ly/ybk-events for 
more information.

ENTER FOR AWARDS
Our parent company, Varsity Brands, hosts an annual 
contest to promote school spirit and community pride 
— and awards $100,000 in 25 categories, including 
yearbook. Make sure to look for information about the 
Varsity Brands School Spirit Awards in January.

yearbook skills are life skills

PORTFOLIO: THE BEST OF HERFF JONES
The annual publication that brings all of our best  
examples together in one place. 



STYLE NAME FONT FAMILY FACE/WEIGHT POINT SIZE LEADING
Headline

Subheadline  
Body copy (9–11) (size +3 or 4)

Portrait names (8–9) (size +4)

Caption starter (8–9) (size +2)

Caption copy (8–9) (size +2)

Bylines (6–9)

COLOR PALETTE COLOR NAME C: M: Y: K:

Color 1

Color 2

Color 3

Color 4

Color 5

SET YOUR STYLES

NEVER PANTONE ALONE
To accurately choose a CMYK color, refer to the colors poster in 
the kit, and talk with your CSA or rep. You also need to know if 
your paper is coated, which is most common, or uncoated.  
It’s especially important to get your school colors exactly right. 
Get help from your rep or CSA and record the formulas here. 

CHARACTER ST YLES
Refer to the Font Collection book for help navigating fonts, 
including size, weight and leading. Then record your choices  
here to keep the font styles in your yearbook consistent. 
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NOTES



Breathe in. Breathe out. It’s OK. We know it’s overwhelming.  

B U T  D O N ’ T  W O R R Y  —  Y O U ’ L L  N E V E R  Y E A R B O O K  A L O N E .
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